Sheet Metal - Basic

ThinkDesign do not force you to follow a single predefined design methodology. Depending on the require-
ments of your project, it is possible to change the approach to design - starting from scratch or starting from an
existing model. This rule also applies to Sheet Metal application. You can mix these approaches and take advan-
tage of the set of specific features and of an enlarged and powerful library of Sheet Metal-specific Smart Ob-
jects. The following exercise will demonstrate how to use Sheet Metal tools to create a casing for a motor. Let's
get started!
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1. Sheet Metal Parameters

ThinkDesign provide a set of global parameters for each session. Right-click on the Graphics Area and click
Options/Properties. Click the Sheet Metal category in the Entity Properties tab to see these parameters, shown
in the image below.

The first step in designing a Sheet Metal part from scratch involves one of the following two methods:
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» Sketching a closed profile (i.e: a rectangle) and extruding it. In this case the Thickness equals the extrusion
depth.

+  Sketching an open profile (i.e: a L-shaped profile) and extruding it with thickness option on ®Thickness. In
this case also the Thickness equals the extrusion depth.
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Alternately, you can use the Solid Flange command to extrude an open profile, then use the Unbend command
to unbend the solids

= % Model3
=B Solid (35)
5 Unbend (42)
& Flange {372
¥ ’a Linear Sweep (35)
=B Solid (22)
5 Unbend (25)
& Flange (24
= ’a Linear Sweep (22)
&> 20 Profile (21)
= solid £13)
8 Unbend (20)
@ Flange {15
B ’ﬁ Linear Sweep (13)
&> 2D Profile (12)
=B solid (2)
5 Unbend (9)
& Flange ()
= ’a Linear Sweep (2)
&> 20 Profile (1)

Now let's start a task that will help us understand the dynamics of working with ThinkDesign Sheet Metal com-
mands.

2. Step 1: The Initial Casing Plate

In this step we will demonstrate how the new sheet metal functionalities are integrated into ThinkDesign 3D en-
vironment.

Open the file motor.e3 from the Webtask installation folder. (This file may have already been opened when you
downloaded and started the "Sheet Metal Basic" executable from the think3 Webtask page.)

The object here is to create a Sheet Metal casing for this Motor and in the process use various ThinkDesign
Sheet Metal functions.

Let's start building the Casing!!
You'll need a base profile that is large enough to encompass the Motor body.

Before you sketch the profile, ensure that your Work Plane is oriented correctly for this exercise.
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The Work Plane and the model must look like the image below. Note that the XY Plane is perpendicular to this

=

-

*  Click on the 2D Profile tab at the bottom of the graphics area to create a Profile. If you do not see the 2D/3D
Profile tabs, Check the option Show tabs Model, 2D Profile and 3D Profile fromOptions/Properties > Sys-
tem Options > General > Advanced Starting from ThinkDesign 2008.1, We have an option of creating both
2D as well as 3D Profiles by clicking on Insert > Profile > 2D or 3D.

+ Start the Polyline command and sketch the Profile shown below. It does not have to be exact -- some general
dimensions are: a horizontal size of 150mm and a vertical size of 140mm. Just make sure the Profile encom-

passes the Motor and that the notch is sketched on the left side.
Ho

CoX Ho

e Start the Linear Solid command.

+ Select the @ Profile you just sketched (if it is not selected already) and Set a extrusion depth of 2 mm in the
mini dialog.
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+  Click ™I OK to create the first face of the Sheet Metal casing.

The base portion of the casing is ready. Now let's go about covering the motor from its sides.

3. Step 2: Build the Flanges

Let's continue building the Motor's casing by creating the side flanges...

» Start the Flange command from ThinkDesign Sheet Metal toolbar.

+ Select the @ Edge as shown below and pull the Flange handle away from the edge...then set the Mini-dialog
as Length120.
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=3 @Flange Lm [!] lﬂ
@ Edoe
- [ Use Profile
Length By value -
O oOffset
= Local Properties
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= @ Allowance
Type K factor -
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& Alignmert Inner flanoe -
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Keep the default values and settings for the other parameters in the Selection List as shown in the image.

«  Click L1 Apply to create this first side flange.

Now let's create a twin flange to the previous one, but on the adjacent edge of the base plate.

* Continue with the Flange command.

+ Select the @ Edge as shown and pull the Flange handle and control the height in a parametric way with
Length Up to Point option.



http://thinkcare.think3.com/thinkcare/help2006/english/sheetmetal/FWfile/T_FW_Flange.htm

Sheet Metal - Basic

(i ;gFIange an M L!J
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- [ Use Profile
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=l Local Properties
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[+ More Options

& Radiuz 2 mm

«  Click ™I OK to finish.

Now let's create another Flange using the edge of the base on the opposite side.

+ Start the Flange command.

+  Select the @ Edge as shown in the image below.
QgFIange w M m
o Edge

#- [ Use Profile
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O oifset i
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#- Reliefz
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LE e e
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In the Selection List:
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+  Expand © More Options and check the Orientation option
+ Set an Orientation of 70

+  Click M OK.

Lets now make a Flange at the center, between the first two flanges that we have created.

» Start the Flange command.

+  Select the @ Edge as shown below.
= gg Flange E_x] M JL!_]
o Edge
#- [ Use Profile
Length By value -
[ Offzet
= Local Properties
[#- Reliefs
= @ Allowance
Type K factor -
K factor 0.33

Radiuz 2 mm

In the Selection List:

* Click on ® Alignment and set the alignment to Inner flange.

+  Click ™I OK.

Notice that the Flange has a Rectangular relief.
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Let's now see how we can change the relief to an Oblong type.

* Right click on the Flange in the History Tree and click Redefine Feature.

E% Mew_carter.e3
Solid (33)

44 Roll Back Here

ﬁ& Deactivate Feﬁre
o

? Delete Feature

h@ Assign Yariable/Feature
- Bl skin (30) r% Hide Driving Dimensions

Rename

Search
Search this Mame

Info 4

+  Expand " Reliefs in the Selection List.

+ In the Reliefs dialog that pops up click the Bend button, then click on® Type to unlock it.

* Select Oblong from the pull-down menu.
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e Edlye
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=]
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* Close the the Reliefs form by clicking the X...

« ...then Ll Rebuild the model

You can see the change in the shape of the Relief.

Let's now cover one more side of the Motor with a Flange.

o Start the Flange command.
+  Select the @ Edge as shown below.

«  Click on ¥ More Options and check Orientation with reference plane as 2 points as shown with the values
with an angle of 10
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«  Click M OK

Let's add another Flange to the remaining side.

Start the Flange command.
+ Select the @ Edge as shown below.
* Create a flange by selecting length up to point and selecting end point on opposite flange as shown below.

Click ™ OK.
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= ngIange [m M LID
° Edlye
& [ Use Profile
@ Lenoth Upto poirt
O Offset
=l Local Properties
[ Reliefs
= & Allowance
Type K factor -
K factar 0.55
@ Rolling Threshold 100 mm
o Algnment Outer flange -
& Length Outer -
[+ More Options

& Radius 2 mm

«  Click ™ OK when finished.

Let's see how easy it is to work with traditional Solid commands on Sheet Metal parts. On to the next step!

4. Step 3. Sketching Sheet Metal Features, and Easy Cre-
ation of Drawings

Now Lets add some side flanges to the casing.

+ Start the Flange command again and select the @ Edge as shown

» Set the length to 119.5 and set the alignment to inner.

11
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(= ;9 Flange @ ED
@ Edge
#- [ Use Profile
Length By value -
O oOffzet
=) Local Properties
- Reliets
= & Allowsance
Type K factor -
K factor 0.33
@ Roling Threshold 100 mm
@ Alignment Inner flange -
& Length Outer -
[+ Mare Options

* Now check the Use Profile and edit the profile as shown .
* Redefine a new circular/rectangular relief on corner in flange local properties with dia8.

* Set a Collinear constraint for the base horizontal line on its edge and a horizontal constraint on top line.
Also, add a coincident constraint as shown.

¢ Insert vertical dimension of 118

* Repeat the same to create the flange on the other side of the casing.

We will use the Sketched Bend command to bend a sheet along a predefined Profile.

* Place the Work Plane on the last created flange .

* Create a parallel line selecting the edge as shown using copy length mode, distance 3

12
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= /f/ Parallel Line LX]
& Point
Type Copy length -
Sequence Single
O Symmetric
[ Halt Plane

Distance |3

» Start the Sketched Bend command.
» Select the line we have drawn just now.

The @ Face gets selected automatically and the preview shows the direction of bend creation.

= o sketchedend (3 W) (1)
& FProfile
° Face
=l Laocal Propetties
= @ Allowsance
Type K factor -
K factor 053
& Rolling Threshold 100 mm

& Alignmert Inner flange -

& Radius 2 mm
- Angle 90 deg

» Ifnecessary, double click on the red arrow to invert the direction of bend, and...
» ..if necessary, double click on the other red arrow to select the smaller corner portion of the face to be bent.
* Set the bend angle in the Mini-dialog to Angle 90 .

+  Click L& Apply from the Selection List to apply the command.
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The first bend is created! Now go for the second one..

* Repeat the same procedure and create the bend on the other flange of the casing.

Sketched bends are easy, aren't they? Now let's examine another command: Unbend.

e Insert two holes of Dia5 as shown below.
e Set the first distance as 13 and second distance as 7.

*  Set the depth of the hole as 30

14


http://thinkcare.think3.com/thinkcare/help2006/english/sheetmetal/FWfile/T_FW_Unbend.htm

Sheet Metal - Basic

=

= Type From 2 lines -
° First Line
& SecondLine Diameter & mm

1=t Distance 13 mm

2nd Distance 7 mm

o e ]

@ Reference planar face

Crepth 30 mm

(=]

red k-
CourterBior
CourterDril
Countersu

We will now Unbend the flanges locally selecting a fixed face.

Start the Unbend command.
+  Click on the flange as shown to specify the @ Fixed Face.

» Set Type Local in the Selection List.

Select the bend as shown to specify the portion of the material to be "unbent."

Click 11 Apply.

You can see from the image below that the Unbend occurs only at the specified portion of the Motor casing.
This is a "local" unbend.
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We will not need this particular Unbend feature for this task -- so Delete it from the history tree or use the
Undo command to undo it.

*  Now move the Work Plane to the top flange.

» Sketch a rectangle in order to make a blind slot of depth 10 to avoid interference between the electric con-
nectors panel and the top flange of the casing.

- B Linear sict () W4 L)
@ Profie

(= Extension Thru next -

@ Face

[#- More Options

*  Now use Unbend command to make a global unfold of the sheetmetal casing selecting the bottom face as the
fixed face.
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= & uneene (€) WA (1D Q)
@ Fixed FaceEdge
Type Global -

[# Local Propetties

*  Now move the Work Plane to inner side of the rear flange as shown

* Now insert a profile as shown.
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* Make a slot with the profile and make it Thru all as shown

» Pattern the slot with a Linear-Linear feature with the parameters as 80mm x 8 and 75mm x 3.

* Use Rebend command with respect to the same fixed face we have used to unbend.
= &% Solid Pattern
° Base Entities

- Type: Linear-linear -

o n
@ st Direction Line -
& 2nd Direction Line -

[#- More Options

8
1055605 mm —— 2nd Extension 801583 mm
3
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¢ Move the Work Plane on to the external side of the bottom face.

» Insert a simple rectangular profile offsetting the external edges as shown.

*  Click on Smart Object Library and click on Insert Smart object and select PUNCH CONIC selecting rectan-
gular profile corners as placing points.

= B Insert smart Okject | €1 v 1)

= Anchar

° Face
@ Point

Orientation Default -

Direction Defaut
@@ 15t Dist
€5 2nd Dist

Showy parameters: None -
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* Now Create a new Profile on the top flange as shown.

» Insert a new blind slot and set the depth to 20mm
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*  Move the Work Plane on to the top flange and add one more profile on the flange as shown.

* Insert a new blind slot of Depth Imm, Radius 0.5 on side and base and 0.1 on ../../Common as shown.
= Iy Lnear it (€] W) (1)
@ Profile

Fillet/Chamfer on Fe... |E||X|

[= Extenszion Blind single depth Tupe: IFiIIet vl
Face
@ R adius: IMuItipIe Vl I‘I 0'mm

= More Options
v 1 mm
Direction Mormal -

=) FilletiChamfer

)|

¢ and the result is.....

Sheet Metal designs are usually presented in their 2D "flat-panel” or "flat pattern" view on a drawing. ThinkDe-
sign has the feature Flat Pattern View (or Insert >Drawing View ¥ Flat Pattern View) to achieve this from
the 3D environment. Let's check it out!

* Right click on the Solid in the History Tree and click on Flat Pattern View.
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ThinkDesign will automatically open a New Drawing with the "flat pattern” View of the selected Sheet Metal
part. The image below shows our casing in its Flat Pattern View.
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You can see that all technical details like the bend lines, bend data, etc. are readily available.

* Right click on the Flat Pattern View and click Properties.

Edit Properties - Flat Pattern

Edit Propertiez ]
=1 Dirawing YWiew Shaw
-1 isibility )

Image ¥ Bend lines
Model Filters W Bend data Y ——
View Attibutes gat i 0 -
Ereak Lines v Remove reliefs

Relief radius

Miscellaneous
" Length: %
{+ Thickness*factor: 15

Forming tools: Wfith thin lines -

Orientation

[ Flip sight direction

Raotation angle Odeg

ak. | Cancel | |

Under the Flat Pattern tab you can control the visibility of the Bend lines and Bend data by checking/unchecking
the boxes.
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*  Now you can insert bend data on to the layout as shown.
Insert Modify  Format Tools Window Help

Drawing Yiew L4 =
g K
Cutting Plane Lines »

4
Break Lines 4 [
Drrafting »
Dimension 4
Ballaon »
Group 4
Foint 4
Curve »
Wisual Bookmark. 4
Markup »
User Defined Properties »

;@ Item Position Property

vz From File...
n' Image

E Drawing Frame and Title Block.

Bend data are associative. Go back to the model and change the value of one or more bends. Go back to the
drawing and regenerate for upto date data..
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* Congratulations... Job well done!.

Lets explore some more features of Sheet metal in ThinkDesign

Some times, when we create flanges, we get to see some gaps at the corners. Lets see how we can close these
gaps using Close Corner command

* Create a sheetmetal component as shown and add flanges. Now click on Close Corner

* Observe the relults by changing Type to Full, Middle and Symmetric.
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= fifil Close comer (3 W) L1
@ Faces

[#- Local Properties

Type Middle -
I Symmetric
J

Let's now see a new command Sketched Rip

* Create a solid as shown and create a profile on one of its faces.

X

Frofile / Line [Length = 15,9447 mm)

o Start the Sketched Rip command by selecting the profile you have created and the face of the solid.
- i sketched Rin (3 &) (1)

Rip by Profile -

Face

- Local Properties

L <N <

- More Cptions

O Propagste to adiacent faces /\

Symmetric

Now see the result. The face of the solid has been ripped.
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This brings us to the end of this task. Congratulations!! We have covered some of the basic concepts of
ThinkDesign Sheet Metal functionalities:

* Sheet Metal Properties

* Flange creation and modification

* Bend/Unbend (locally and globally)

* Flat Pattern View creation

* Solid operations on Sheet Metal parts

+ ...and much much more!

Now you are ready to create your own personal designs with ThinkDesign Sheet Metal. Good luck!

A.

* Sheet Metal workflow in ThinkDesign.
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